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Aide-mémoire

Barre d’outils CWYW

| EN Go to EndNote APA 6th Capy

Style:
E,| Update Citations and Bibliography

=R =P Edit Gitation(s)

Insert o
ﬁ Edit Library Reference(s)

Citation ™ @Convert Citations and Bibliography ~

Citations Bibliography E

= ﬂExport to EndMote ~
c'gy Preferences
? Endhote Help

Tools

EN Go to EndMate 4/‘| Cherche une référence dans EndNote |

& _:_f Edit Citation(s) */—I Permets de modifier une citation |

| Insert

Fitation ™ @ Edit Library Reference(s) ¢«—

Bascule vers le bordereau de saisie
dans EndNote

Passe du document Word a EndNote

Find Citation... L

lji‘j

ey Insert Mote
Permets d’insérer une note

. o Insert Selected Citation(s)
Insére une citation provenant de

EndNote dans Word

3
@

Find Figure...

A\

Recherche une figure ou un tableau
dans votre bibliothéque EndNote et
I’insere dans le texte

Style: |APA 6th Copy - ‘D]Expc:

\_:5| Update Citations and Bibliography 4—%#@—

ﬂ Convert Citations and Bibliography ~ ? Endn

Remets une citation dans sa forme

Formate les citations temporaires et
met en forme la bibliographie & la fin
du texte

temporaire et supprime la
bibliographie correspondante

é Convert to Unformatted Citations

Supprime les codes cachés liant le

C .
document Word a EndNote i i) | Convert to Plain Text

lg] Convert Word 2007 Citations to EndNote

Permets de transformer des citations
Word compatibles avec le format
EndNote

|ﬂ Export to EndMote ~

ﬂ Export Traveling Library <

ME)  Export Word 2007 Citations

Exporter les références du texte dans
une autre base de données EndNote
ou ouvrir une nouvelle bibliotheque
avec les références contenues dans le
texte

M) Export Word 2007 Master List




Bibliographies

Imprimer une bibliographie
1. Choisir les références désirées.

2. Sélectionner le style voulu.
3. Aller a File>Print preview pour visualiser et lancer I’impression.

File Edt References Groups Tools ‘Window Help

:Be Arnotated VE‘;}'_@Q@@% L @\Ej@ @
e S elct Ainither Shyle,. - -
1 bnnotate Auteur Année Titre
i | Falud 2010 Fighting Terror as a Business
— A5, Style Manual eresz 2010 Some insured workers still rely on sta
Uniiled ﬁ“‘hg"[’ad‘e eller 2010 How Can Education Policy Improve |,
Trash . skowitz 2010 IOM report favors gov role in CWE
Mv Grou sVetMiCTObiO'ODP Cherchye 2010 Efficiency and equity in private and p.
Y P Willner 2008 The impact of budget cuts and incent
@Formation (18) | Stoppelenburg 2009 Defixation as an Intervention Perspa.
Radin 2009 The Relationship Between OME and
by Srn.art.Groups Guebec (Pro.. 2009 Projet d'aménagement d'un complex.
Adefixation ([ b Organisation.. 2009 PISA data analysis manual SAS
‘@ Evaluation (57) Organisation .. 2009 PISA data analysis manual SPSS
@ politique (148) B ONeil 2009 CHARTER REFORM
Lawrence 2009 Adopting Direct Democracy: Tests of
Online Search Joshi 2009 Autonamy or organisation’? Refarms
OU du QuebeciU... (0 Edelenbos 2009 The Institutional Embedding of Intera.

£ EndNote X3 - [Admpub]
Suivante || Précédente | |Deu pages [Zoom avant] 2o ariére [ Fermer ]

Admpub.enl Page 1

|soonitz, M. (2010, 100 report favers gov role in CME. Mediea Marveting amd Wedia,
2501, 16,

Radin, B. (2008). The Relafionship Between OMB and the Agencies in the Obama
Administration. drdemations Jovms! of Feile Adwinistradon, 32090, 781,

Stoppelenburg, A, &Vermaak, H. (2008). Defication as an Intervention Pespe dive:
Understanding Wicked Problems atthe Dutch Ministry of Forign Affairs.
douma of Maragesent inpuiry, 18(1),40.

Wilner, J., & Grinblom, 5. (2009). The impact of budaet cuts and incentive wages on
academic work. frtemationa! Revew of Anpled Ecoromics, 2315), 673

Exporter une bibliographie (rtf, txt, html et xml)

1. Choisir les références desirées.

2. Aller sur File>Export.

3. Dans la fenétre Export File Name, sélectionner le format désiré
*Le format rtf est habituellement utilisé.

4. Choisir le style bibliographique dans le menu Output style.

Mo du fichier ; |.-'1'-.-:Im|:|u|:| W | I Enreqiztrer ]
Type: Text File [*.kxE] | Annuler |

Output style: Rich Text Farmat [*.rtf]

HTHML [* htri]
AML [P xml]




Copier/coller une bibliographie dans Word

Choisir les références désirées. Pour en choisir plus d’une, maintenir la touche Ctrl
enfoncée.

| EndNote X3 - [Admpub]
ﬂFiIe & References Groops  Toals  Window  Help
E )

B¢ - MT 0000 e EEver -

My L E:tw E::;i Alteur Annee Titre

m Keller 2010 Howe Can Education Policy Improve |
Cherchye 2010 Efficiency and equity in private and p.

!U”f Clear Wiillner 2009 The |mpact of budget cuts and mcent

UTra  selectal Chrla Q¢ ) or !

Stoppelenburg 2

Copy Formatted kel

1 My Change Texk... Chrl+R ':JLIE'tlE'I: Il"::. ro.. ¢
B ’ Organistion... 2008 PISA data analysm manual SAS
@ Siee M Organisation... 2009 . da T
Style POl 2009 CHARTER REFORM
"My Output Styles W Lawrence 2009 Adopting Direct Demc

1. Aller a Copy Formatted )
2. Une fois dans votre document Word, cliquer sur Edition>coller

** N’oubliez pas de choisir le format bibliographique souhaité.

Bibliographie thématique

1. Sélectionner Tools>Subject Bibliography.
2. Choisir les champs que vous voulez voir apparaitre dans la bibliographie.
Subject Fields X

Selected Fields: Select Al
Reference Type A -
— Clear Selection(s)

Secondary Author

Secondary Title =
Place Published

Publisher

Wolume

Murnber of Yolumes

Murnber

Pages

Section
Tertiary Author
Tertiary Title
Edition

Date

Lisk each authar separately
Cancel
0 In other fields, list each entry that is separaked by slash, carriage
rekurn or line feed, (Keywords entries are always listed separately.)

| £




3. Sélectionner la liste de termes & inclure.

Subject Terms

=

Selected Terms

Processus de recherche @ une approche syskémique
Programme d'aide & la recherche sur l'enseignement et l'appren. ..
Programme des sciences ek technologies émergentes (Canada)
Pragramme inkernational pour le suivi des acquis des éléves,

Projet d'aménagement d'un complexe hydroglectrique sur la rivi. .
Public adminiskration : palicy, politics and practice

Public administration and public affairs

Public budaeting and management
Public sector management
Purchase, Bryne Brock,

Qualite de la vie au travail : evaluation et mesure
Quebec (Prov.) Service de 'econonie minerale

Québerc (Province), Comiké inkerminiskérigl sur 'employahilicé

Cuébec (Province), Conseil des colléges

£

Cuebec(Prov, IDirection Generale des Forets, Service de la Rech. ..
Queen's University (Kingston Ont.), Social Program Evaluation ...

Cuébec (Province). Bureau d'audiences publiques sur 'environn. ..
Québec (Province), Camiké interminiskériel de coordinakion enm...

Québer (Province), Commission des droits de la personne et de..,

# Records

0N = = D) = =

(U L TSR R . PR Y

b

| >

4 Termis) Selected

Select all
Clear Selectionis)

k.

Cancel

Help

Numéroter les références et ajouter un espace entre chacune d’elles

Ouvrir le gestionnaire de style dans EndNote.
1. Edit >output styles > Open style manager.

Output Styles L4 MNew Style...

Import Filters 4 Edit "APA 6th"
Connection Files 4 Open Style Manager...
Preferences... Annotated
Annotated Copy
1bMed (NLM) (0) APA 5th
STA (EBSCO) (0) APA 5th Copy
orary of Congress (0) v APA 6th
3 APA 6th Copy
. Author-Date
Jote Web Author-Date Copy
\filed @) L Numbered
st (10) ’; Show All Fields

2. Sélectionner le style désiré.




3. Cliquer sur Layout sous la section Bibliography.
Fa| EndMote X3 - [APA 6th]
e File Edit Refererkes Gr

\
|[Plain Font |F'Ia\8ize
- About this Style
— Anonymaous Works

- Page Numbers

- Journal Names

- Sections

- Citations
Templates

- Ambiguous Citations

- Author Lists

- Author Name
MNMumbering

Iiograph
Author Lists
Author Name
- Editor Lists

- Editor Name
Layout
Sort Order
- Title Capitalization

=l Footnotes

Templates

Author Lists

- Author Name

- Editor Lists

Editor Name

Repeated Citations

- Title Capitalization

=- Figures & Tables

Figures

Tables

- Separation & Punctuatior

4. Dans la fenétre Start each reference with, sélectionner Bibliography number dans
la liste Insert field. Ajouter une ponctuation si nécessaire.

Start each reference with: InsertField  »

5. Dans la fenétre End each reference with, sélectionner End of paragraph dans la
liste Insert field.

End each reference with: InsertField »




Créer une bibliographie a partir de plusieurs documents

1. Déformater les documents Word et enregistrer en format .rtf.

2. Aller dans EndNote. Tools > Format paper > Format paper.
IGGI Window  Help

Search Library.. Ctrl+F | m = @ ‘ @ “E
Spell Check Cirl + _
Cite While You Write [CWYW] 4 | JotL
Online Search... Terror as a Business  Sex
Change and Move Fields...
1 C\Users\..\Desktop\test 1
EndNote Web... 2 CA\Users\..\Avenirbibliomtl
ort favors gov role ... Me
Open Term Lists L d .g . . E
Define Term Lists... Ctrl+4 yan eqmty inpriva... ul
Link Term Lists... cirl+3  Jact of budget cuts a... Inte
e Tan P n as an Intervention... Jou
ide Tab Pane . .
) ationship Between O... Inte
Sort Library... \ . \
Recover Library.. amenage-_ment d'un... Ra
: ta analysis manual ...
Library Summary.. ta analysis manual ...
Subject Bibliography.. R REFORM PN
Manuscript Templates.. y or organisation? ... Pul
Datavisualization) itutional Embeddina ... Am
3. Repérer le premier document & formater.
Fa'| Quvrir ﬁl
‘QQ |- Bureau - ml Rechercher dans : Bur..
Organiser ¥ Nouveau dossier 'jZ: =~ j G
- e =
. Favoris —I
B Bureau ]ik Admpub Copy.Data
+» Emplacements récents ‘l.‘ Dossier de fichiers
4 Télechargements
k Bureau
) I r Dassier de fichiers
. Bibliothégques
Raccourci vers klamontagne$ sur
. i ——» nestor (U)
& Ordinateur Lﬁ‘/ Raccourci
y ; L testl
& Reseau 'E ®= Rich Text Format
355 Ko
@ . test2
®= ' Rich Text Format
351Ko ~]
MNom du fichier : || j |AII Formats (*.rtf;*.odt) j

Cuvrir |V| Annuler |

Y




4. Cliquer sur le bouton Scan next et sélectionner le deuxiéme document a formater.
Apreés chague document, les citations s’ajoutent dans la fenétre

P2 EndNote X3 - [test 1] — |5 x|
==X
‘ Matches |
1 Chapron, 2009 #10
1 Morin, 2008 #208
1 Enjoiras, 2008 #7755
1 Fiyde, 2004 262 | [ Ouvrir X
( :‘( :/ M Bureau ~ ~ &3 | Rechercher dans: Bur.. )]
Organiser ¥  Nouveau dossier 8= ~ d 9
TS T e a
Favoris J
M Bureau J | Admpub Copy.Data
~» Emplacements récents i Dossier de fichiers
¢ Téléchargements
i Bureau
) r Dossier de fichiers
.| Bibliothégques
Raccourci vers klamontagne$ sur
r ~ - ‘nestor’ (U) 18|
A Ordinateur A= Raccowd ‘
i Rs o L testl
& Reseau 1= Rich Text Format
36,7 Ko
m test2
Rich Text Format
53,9 Ko ~]
.
Show Nom du fichier: ‘test 2 j |AII Formats (*rtf*.odt) j
- = Matched Ciations 4
— 0
| 0
Output
Output Style: |APA 6th hd
Start Bibliography numbering
Format... Close
Ready INUM
Exvemarrer| 1oy | | iz ) AECm@r @D P m
=/ = — < v 2010-03-25

Lorsque tous les documents ont été parcourus, cliquer sur Format.
6. EndNote génere une copie de chaque document avec les citations formatées et une
bibliographie cumulative a la fin du dernier document formaté.

o

L’édition de la bibliographie
a) Deéplacer une bibliographie
1. Désactiver la fonction Instant formatting.
2. Sélectionner la bibliographie en prenant soin de saisir tous les codes,
puis copier-coller a I’endroit désiré.

b) Supprimer les codes de champ ** Cette fonction est utile si vous voulez
partager un document final, a un éditeur par exemple, sans possibilité de
modifications des références.

1. Cliquer sur I’onglet Convert citations and bibliography et choisir
Convert to plain text.

2. Une copie de votre document sans les codes sera créée et I’originale
restera intacte.

3. Enregistrer sous un autre nom.



Insérer une référence dans la bibliographie sans citation dans le document

Méthode manuelle

1. Supprimer le nom de I’auteur et I’année de publication de la citation non
formatée. Ne laisser que le numéro de référence.

2. Lors du formatage, la référence apparaitra dans la bibliographie, mais la citation
disparaitra du point d’insertion.

Méthode assistée

1. Cliquer sur la fonction Edit Citations de la barre d’outils.
2. Sélectionner la référence puis cocher les cases Exclude Author et Exclude Year

Créer une bibliographie par section

1. Dans Word, cliquer sur I’onglet Mise en page

2. Sélectionner le menu Sauts de page

3. Choisissez une des quatre options

4. Dans la barre EndNote, sélectionner un style qui contient le terme Section

- About this Style

- Anonymous Works
- Page Numbers

- Journal Names

- Sections

=- Citations

- Templates

- Ambiguous Citations
- Author Lists

- Author Name

- Numbering

- Sort Order

- Bibliography

- Templates

- Author Lists

These options allow you to create multiple bibliographies in a single Microsoft Word
document when using Cite While You Write (CWYW). According to the type of style you
are working with, choose how citations should appear for each section and document.

Sections
(& Create a complete bibliography at the end of the document
(— Create a bibliography for each section

-
Create a bibliography for each section and a complete bibliography at the
-~
end of the document

Mumbering will continue, and settings for disambiguation and repeated
citations will be applied across sections.



Citations

Il peut y avoir deux formes de citations
1. Citation formatée : signifie qu’un style particulier lui a été appliqué. Elles
contiennent des codes les reliant a leurs champs dans la base de données EndNote.
Exemple : (Chapron & Delamotte, 2009, p. 5)
2. Citation non formatée (temporaire) : signifie qu’elle est provisoire. Elle permet
a EndNote de repérer les informations bibliographiques qui seront nécessaires lors
du formatage. Une citation non formatée contient habituellement le nom de
I’auteur, I’année de publication mais surtout le numéro de référence. On la
reconnait grace a la présence des accolades.
Exemple : {Chapron, 2009 #6@5}

Style: APA Gth A\ t’L Expo
s ;| Update Citations and Bibliography gﬂ Prefe
| 3) Convert Citations and Bibliography - ? Endm

P> ) onvert to Unformatted Citations
‘.:g Convert to Plain Text

Uil Convert Word 2007 Citations to EndMote

Ou

EndNote X3 Format Bibliography &

Format Bibliography | Layout Instant Formatting | Libraries Used |

Instant Formatting

Instant Formatting automatically updates your
reference list as new citations are added to a

document.

Instant formatting is currently off.

Turn On

10



Insérer une citation dans un document Word

Procédure 1
1. Placer votre curseur ou vous voulez voir apparaitre la citation dans Word.
2. Cliquer sur I’icone avec une petite loupe de la barre d’outils EndNote.

e EM Go to EndMote

N ._.f Edit Citation(s)
— » Insert
_— ”Af Edit Library Reference(

Citation -
&4, Find Citation.., «——
* Insert Mote

i Insert Selected Citation(s)

ﬁ Eind Figure...
3. Choisir Find Citation(s).
4. Faire votre recherche et sélectionner la référence a citer dans la boite.
5. Cliquer ensuite sur Insert et la citation apparait dans le document.

EndNote X3 Find & Insert My References ﬁ
formation v
Authar et Tikle £
Bégin 1999 Le systéme de santé québécois @ un madéle en transformation
Canada, Conseild... 1990 Morme de classification : administration des programmes : categorie de 'administration et du service exterieur, =
Canada. Conseild... 19390 Morme de classification @ organisation et méthodes : cakégorie de l'administration et du service extérieur, = Classi
Chapron 2009 Wers une éducation 3 la culbure informationnelle: jalans et perspectives
Chapron 2009 Wers une education & la culture informationnele: jalons et perspectives
Colas 1992 La formation & l'usage de l'information dans I'enseignement supérieur
Dooren 2005 Perfarmance information in the public sectar @ how it is used

Dupont 1992 La place de la Formation documentaire dans la Formation unlvemta\re

Gouvernance et inkérét général dans

Ethigr 1994 L'Administration publique ; diversité de ses problémes, complemte de sa gestion

Goldbaum 2004 Paleontologists Use Computer to "Morph” Deformed Fossils Back to Their Original Shapes

Hall 1999 Late Bajocian and Bathonian (Middle Jurassic) ammonites from the Fernie formation, Canadian Rocky Mountains
Kingshury 2005 Les déterminants de I'évaluation de la langue : & 'enseignement collégial, pourquai et jusqu'ol évaluer la compéte
Le Deuff 2007 La culture de linformation: Quelles «littératiess pour quelles conceptions de linformation?

Mations Unies, Dé,.. 1989 Management of government information systems : elements of strategies and policies w
< >
Reference Type: EBook ~
Record Number: 205
Author: Enijoiras, Bernard

Centre interuniversitaire de recherche d'information et d'enseignement sur les coopératives.,

Year: 2008

Title: Gouvernance et intérét général dans les services sociaux et de sante

Series Title: Economie soriale & Economie publique

City: Wienne

Publlsher Peter Lang

Series Yolume: 1

Number of Pages: Z65p.

ISBN: 9789052013923

Accession Number: 030031997 /\ A

N
w’ \‘ Cancel ] [ Help ]
\ /

L —
Library: Admpub.enl V 27 items in lisk

Procédure 2
1. Placer votre curseur ou vous voulez voir apparaitre la citation dans Word.

2. Cliquer sur le bouton Go to Endnote EM Go te EndNote
3. Sélectionner manuellement la référence voulue dans votre base de données.

4. Cliquer sur I’icone Insert citation @ ou, aller a Tools>CWYW=>Insert selected
citation(s)

11



Insérer une citation multiple

Procédure 1

Il vous suffit d’utiliser la procédure 2 pour I’insertion d’une citation simple, mais de
sélectionner plusieurs références simultanément en maintenant la touche Ctrl enfoncée.

Procédure 2
Sélectionner les références dans votre base de données et faites un copier-coller de la

citation a I’endroit voulu dans Word.

**Pour insérer une référence dans une citation existante, insérer la citation a coté de
celle-ci sans espace ; les deux se fusionneront.

12



Insérer une note de bas de page
AB'

Insérer une note

1. Créer une note de bas de page dans Word ¢ bas d= page
2. Utiliser les procédures d’insertion de citation.

Remplacer les titres répétitifs des notes de bas de page par Ibid.

1. Dans EndNote, aller a Edit>Output Styles>Open Style Manager.
2. Sélectionner le style voulu.

3. Sous Footnotes, cliquer sur Repeated citations.
- About this Style

- Anonymous Works
- Page Mumbers

- Journal Names

If a Reference Repeats in a Subsequent Footnote
[ Use the short form of the reference

—

) S-ECTI_CIHS If the Same Reference Repeats in Consecutive Footnotes
= Citations
- Templates (@ Replace repeated data with: lbid.
-~ Ambiguous Citations " Omitrepeated data
- Author Lists (" Mo special handling
- Author Name
- Mumbering Ifthe Same Source Repeats in Consecutive Footnotes
- Sort Order

(@ Replace repeated data with: Ibid.
= Bibliography

--Templates

- Author Lists

- Author Mame

-- Editor Lists

- Editor Name

- Layout

- Sort Order

- Title Capitalization
= Footnotes

- Templates

- Author Lists

- Author Name

-- Editor Lists

- Editor Name

-- Repeated Citations
-- Title Capitalization

[ Replace only the secondary title
~ Mo special handling

** Si vous ne pouvez pas inclure de numéro de page a Ibid, c’est que le style ne le
permet pas. Il faut alors procéder manuellement. Cliquer sur Edit citation de votre
citation formatée et inscrire le numéro de page dans la boite Suffixe.

Vous pouvez aussi inscrire le numéro de page manuellement a c6té de votre Ibid
formaté.



	Aide-mémoire
	Barre d’outils CWYW
	Bibliographies
	Imprimer une bibliographie
	Exporter une bibliographie (rtf, txt, html et xml)
	Copier/coller une bibliographie dans Word
	Bibliographie thématique
	Numéroter les références et ajouter un espace entre chacune d’elles
	Créer une bibliographie à partir de plusieurs documents
	L’édition de la bibliographie
	Insérer une référence dans la bibliographie sans citation dans le document
	Créer une bibliographie par section
	Citations
	Insérer une citation dans un document Word
	Insérer une citation multiple
	Insérer une note de bas de page
	Remplacer les titres répétitifs des notes de bas de page par Ibid.

